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Notice 

No meetings in July 
and August 

8 Hurricanes in 
15 months! 

2005 Season 
Is that a record, 

or what? 

The previous hurricane season was a killer diller!!!   Let’s 
hope and pray that will not be the case this season.   

 

However, as we wait and see let us not rest on our laurels 
and just hope the big winds will not come. Be Prepared! 

 

An excellent guide to preparedness is the                           
Walton County Family Preparedness Guide—at 

www.co.walton.fl.us 



Cyber Chat is published monthly by the 
ChautauquaCyber Club, Inc. It is distributed to 
each member and made available to the public 
through local business, educational, and public 
library organizations.  

The Chautauqua Cyber Club, Inc. is in no way 
responsible or liable for any damages resulting 
from articles, opinions, advertising 
representations, warranties expressed or 
implies in this publication. We do not endorse   
or recommend products or services. Comments 
or opinions do not necessarily reflect the 
policies of the Chautauqua Cyber Club, Inc. , 
Board of Directors. 

The principle of equal access/equal opportunity  
for everyone is practiced. 

The primary purpose is to assist our members 
and others to become more proficient in the use 
of a computer for their personal enjoyment. We 
serve through promotion of computer literacy 
and education by being actively involved in the 
community. 

The Chautauqua Cyber Club, Inc. is a not-for-
profit organization under section 501(c)3 for 
educational purposes, and incorporated under 
the laws of the State of Florida.   

ADVERTISING: Contact  

Ernest “Sonny” Hollingsworth 

Tel: 892-2456      

Email: sonnyh@defuniak.com 
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Donate Your Old Computer 

Help Promote Computer Literacy and Education 

in Walton County 

Pentium II , III, and IV class computers, monitors, 
and printers in working condition are accepted 

Receipt issued upon request for tax credit 

Chautauqua Cyber Club, Inc.—      501(c)3 

To make a donation call  

    Bob King—951-2378                                                  
or                                                                      

J. B. Hillard 892-3450 / 892-8100 

J. B. Hillard President 892-3450 jbh37@panhandle.rr.com 

Garth Corbin Vice President 892-0848 cor21bin@netzero.com 

Bess Ross Secretary 892-7823 bessross@msn.com 

Gay Russ Treasurer 892-7452 mgruss@defuniak.com 

Sonny Hollingsworth Member at Large 892-2456 sonnyh@defuniak.com 

Tim Polito Web Master 835-7746 polito@direcway.com 

J. B. Hillard Editor 892-3450 jbh37@earthlink.net 

Jerry Fulaytar Assistant Editor 892-0103 goodwaters@defuniak.com 

Dan Owens Director-Community         
Service 

892-4232 wdowensiii@yahoo.com 

Sam Sloan Technology Manager 892-9329 scecil@panhandle.rr.com 

Robert King Inventory Manager 951-2378 rwking@defuniak.com 

Gay Russ Leader—Genealogy SIG 892-7452 mgruss@defuniak.com 

Rella Bierbower Director-Social Services 892-3782 rellahsd@earthlink.net 

Estelle Norman Membership 834-2564 ewn@gtcom.com 

Board of Directors and Volunteer Staff 

Months     1     3     6    12 

Business Card 3.5 x 2 $10.00 $15.00 $27.00 $42.00 

Quarter Page $18.00 $26.00 $45.00 $87.00 

Half Page $30.00 $43.00 $7600 $87.00 

Full Page $52.00 $75.00 $135.00 $236.00 

     

Advertise  

Publishing information:  Articles submitted 
for publication should be in Microsoft Word or 
regular ASCII text and unformatted. Photos 
with article are encouraged. 

Presenters/Writers:  Members are encouraged 
to volunteer and present a program on software 
or hardware. Vendors will provide presenta-
tions-in-a-box, and publishers will provide 
books for review. Whatever is presented be-
comes the property of the presenter. Make your 
interest known and share. You will be surprised 
at what all is available to demonstrate. 

Cyber Chat:  This newsletter is prepared using 
Microsoft Publisher 2003, a homebrew 3.2 MHz 
PC, Canon ip4000 printer and Canoscan 8400f.  

New Advertising Rates 
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Boot n’ Reboot  
by J. B. Hillard—President 

     
                                                    

 

 

 

 

 

Frankly, it feels good to 
slow down for the sum-
mer, that is, if there is 
such a thing as me slow-
ing down!  At least some 
of my running here and 
there will be put on the 
back burner until the fall.  

This issue of Cyber Chat 
is emphasizing hurricane awareness and preparedness. 
The county has an excellent guide and Gab Goldberg 
gives us a head-up on accessing family accounts in case 
of an emergency.  So please be aware! 

After we come back from summer vacation and start up 
full steam in September we will be getting ready for the 
Smart Computing Magazine presentation on October 7.  
Right now we are working to confirm the location at 
Okaloosa-Walton College. The word will go out as soon 
as the details are finalized. 

Following good times in October it will be time to start 
nominating new officers for 2007. They will be elected 
and installed at the December annual meeting.  Also, 
volunteers to fill various positions will be needed. Hope-
fully some of the faithful will remain but new blood will 
also be needed.  It’s six months away, but we will need 
a new Editor for Cyber Chat. Seven years is long 
enough for yours truly!  Anyone who would like to learn 
how to publish a newsletter should make it known 
soon . If training is needed we will have time to get it 
done. 

Be sure to prepare your household for the hurricane 
season, and be safe if we get another big wind. 

   Happy computing,  J. B. 

 

 

 

 
Community Service Program 

“People Helping People” 

Announcement 
Smart Computing Magazine 

www.smartcomputing.com 

 Oct. 7, 2006 

Okaloosa-Walton  

Details to be announced 

   Affiliated with 
 

 

Announcement 
Monthly meetings for July 

and August are suspended. 

 

Next meeting September 16 

Room 201 

OWC Chautauqua Center 

 

Bob is retiring from the 
community service project, 
and Roy Hobbler is taking 
over the data base. Pic-
tured below is where Bob 
spent the last 18 months 
maintaining order and 
accountability for the re-
furb shop.  Our sincerest 
appreciation goes out to 
Bob for a job very well   
done.   

Bob King                          
Volunteer Extraordinaire                 

Katrina Red Cross Center 
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Recycle old ink cartridges 

Turn in your old ink cartridge at next 
meeting and help protect the environment 

while earning money for the club 

Jen Clausen from Smart Computing discussed many 
aspects of the Smart Computing website that are 
available to paid subscribers during her presentation 
here on February 23, 2006. These guidelines will help 
you to get the most out of Q & A Board. 

 

 

 

The responders that answer questions on the Q & A 
Board are unpaid volunteer subscribers and NOT paid 
employees. While most responses are accurate, some-
times there are incorrect responses which many times 
can be attributed to incomplete or erroneous informa-
tion provided by the poster. I suggest that you do NOT 
do anything radical to your computer based upon one 
response – wait for a consensus! 

1. First go to: http://www.smartcomputing.com/ 

2. If this is your first visit since becoming a subscriber 
or if a cookie did not keep your Log In data, you will 
need to Log In manually. Checkmark to make a cookie 
and future Log Ins will be automatic. DO NOT Log 
Out of Smart Computing or manually delete the SAN-
DHILLS cookie– if you do, you’ll need to Log In again. 

3. Click on any link to the “Q & A Board”. (There are 
several on the Home page.) 

4. Click on the link “How To Use The Q & A Board” 
located on the right side above the questions. This is 
useful information, so I’ll only emphasize key points in 
this article. 

5. Now click on the link “Set Options” in the same 
area. You should enter the specifications for your com-
puter. This greatly assists responders and they will 
assume your question relates to that computer unless 
you specify otherwise. Plus, there are settings on how 
you would like to review the postings. 

6. Before posting a new question, scroll to the bottom 
of the page and Search to see if your question has pre-
viously been answered. 

7. If a Search is unsuccessful, then click “Post A Ques-

tion” on the right side at the top of the list of Board 
links. 

8. Pick a Subject name that best describes your ques-
tion. Put some “eye-grabbing” details in the first cou-
ple of sentences, as this is what potential responders 
see as they scroll through the posts. 

Then, provide as much specific information as possible 
including program, hardware, error messages, etc. 
that will narrow down the problem. That detail plus 
complete computer specifications in “Set Options” will 
allow responders to zero in without time-consuming 
follow-up posts to get more information! When you are 
finished typing, REREAD your post – you will not be 
able to edit or remove your post! Smart Computing 
moderators do review the Board for and may remove 
inappropriate posts, but they don’t “correct” posts. 
When you are ready, click the Send button ONCE and 
wait for it to be accepted, which can take some time if 
the Board is busy. 

Suggestion: If you have a complicated question, type it 
up first in a word processing program. This will help 
organize your thoughts and improve your post. Then 
you can copy the text and paste it directly into the 
Question block. Remember to enter the Subject. 

9. Once returned to the main page of the Q & A Board, 
you must REFRESH/RELOAD the page to be able to 
see your post. It may take a minute or two for the post 
to show up. 

10. Now you can click on the “View Full Question” link 
in your post. 

11. From this window, you can click “Subscribe To 
This Message” to get an email alert if a response is 
made.     

If you want to clarify or add something you left out, 
click on “Click Here To Answer Or Reply”. 

12. To come back later and review your post, click 
“View My Questions” near the top right of the Board’s 
main page. Then under the desired question, click 
“View Full Question and # Answers”. 

                                  

 

 

 

Computing Q&A Board 
By Michael Hanst 
Lake-Sumter Computer Society, Leesburg, FL      
Member of Smart Computing Q&A Board 

editor@lscs.us 

Editor:  Jen Clausen will be presenting 
the Smart Computing program on Oct. 7 
in the Okaloosa-Walton area. Final 
plans to be announced. 
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13. Review any responses. If you need to reply to a re-
sponder or add anything, click the link “Click Here To 
Answer Or Reply”. 

It is important to keep threads together for continuity. 
DO NOT make another post about the same Subject 
unless your original post is “stale” and there have been 
no responses for several days. Please give feed-
back/thanks ON YOUR ORIGINAL POST as to 
whether suggested solutions worked or not. This is 
courteous to the responders and assists other subscrib-
ers who read your post. 

14. Likewise, if you wish to respond to someone else’s 
post, click the link “Click Here To Answer Or Reply”. If 
desired, click the link “Subscribe To This Message”.  

You should also come back later and review all the 
posts you have answered by clicking “View My Re-
sponses” near the top of the Board’s main page. Pro-
vide a follow-up response if needed. 

If you ever want to reference another post, create a 
clickable link by typing “#” immediately followed by 
the post number without spaces or punctuation; for 
example: #123456 will create a link to #123456 

If you reference another website, provide the entire 
URL to make a clickable link. If the URL is very long, 
use this site recommended by Smart Computing to 
make a “tiny” URL: http://tinyurl.com/ 

15. The “My Personal Library” is a convenient way to 
store links to both Q & A posts and Smart Computing 
and other Sandhill’s articles.  

The Editorial Committee of the Association of Personal 
Computer User Groups (APCUG), an international or-
ganization of which this group is a member, brings this 
article to you. 

 

 
We know it's important to maintain current wills, pow-
ers of attorney, medical directives, and other such 
documents. With much data now stored electronically, 
emergency preparedness includes planning for family 
members, trusted friends, and advisors to access per-

sonal information stored online, on computers, and in 
electronic gadgets. More >>> 

Access Family Accounts in Emergencies 

It's clear how important it is for each of us to maintain 
current wills, powers of attorney, medical directives, 
and other such documents. And family members, 
trusted friends, and advisors such as lawyers need 
quick access to them. In their absence, at stressful 
times, important actions and decisions become need-
lessly difficult. 

With much data now stored electronically, emergency 
preparedness requires that loved ones or advisors can 
access personal information stored online, on com-
puters, and in electronic gadgets like cell phones and 
PDAs (personal digital assistants, Palms and Pocket 
PCs). This preparation merely adds our electronic lives 
to a readiness checklist. 

It's no more exotic or worrisome than opening joint 
bank accounts or giving a house key to a trusted 
neighbor. 

Actions we should take are as unique as our legal, 
medical, and financial profiles. Preparation is espe-
cially important because laws and business practices 
don't match today's technologies. 

News stories highlight some of today's challenges and 
risks. A soldier in Iraq used e-mail and a Web site to 
communicate with the world. When he was killed, his 
parents wanted to preserve what he had created. But 
his ISP refused to allow access or provide the data, 
citing privacy concerns. Similarly, when a Texas man's 
wife died, he cancelled her cell phone.    The company 
also disconnected his phone, which had been on the 
same account. He couldn't reactivate it, leaving him 
isolated at a difficult time. 

Where to begin? Many such legal and logistical prob-
lems can be avoided by simply including two names on 
accounts such as online banking and investing, mort-
gage service, bill paying, e-mail, and Web services. 
This way either person can deal with accounts on the 
other's behalf. But ensure that both names aren't re-
quired for routine actions. 

Then record account names, passwords, and Web ad-
dresses for family members, trusted friends, or a law-
yer, accountant, or executor. They needn't have the list 
until it's to be used so just ensure that they can find it 
and that it's kept updated. 

Those of us in the baby boomer "sandwich generation" 
may have parents and children to look out for and with 
whom to share our technology preparation informa-
tion. 

Accessing Family Accounts in 
Cases of Emergency 
By Gabriel Goldberg, APCUG Advisor; 
Columnist, AARP Computer & Technol-
ogy Website, www.aarp.org 
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 Digital Voice Recorders  
 
I recently explained how to use your PC 
for voice recording. Well, portable digital 
recorders are also available. I bought an 
Olympus WS-320M unit that is also an 
MP3/WMA flash drive player with one 
gigabyte of storage capacity. (Larger ca-
pacity units are also available.)  

 
Like most digital music players it is quite small, but 
performs beautifully. In addition to a stereo earphone 
output, it also has a built-in monaural speaker. It even 
has an input that will accommodate a stereo micro-
phone setup.  
 
The built-in microphone works fine for voice recording, 
but is very sensitive to one's hands on the device. I 
overcame this with a combination headset/microphone, 
and may buy a unidirectional mike that would pick up 
even less background sounds.  
 
I find navigating the device to be wonderfully easy, 
going from listening to podcasts downloaded from 
online radio stations to playing favorite MP3s 
downloaded from my music pages. (I'm too cheap to 
subscribe to any online music services.) Switching be-
tween playing and recording is also remarkably easy.  
 
Attached to a PC via a USB cable, the device shows up 
under My Computer as an additional disk drive, with 
five ready-made folders in which you can save your 
recorded voice files. A sixth folder named Music will 
hold hundreds of MP3 and WMA files. Just drag and 
drop them from your PC's music folder(s). Files can be 
deleted via your PC or with the unit's built-in Erase 
command. It couldn't be much easier.  
 
The recorder/player is powered by a single AAA alka-
line battery, which can be easily replaced when 
needed.  
 
We bought the Olympus online from www.amazon.com 
for $164 (a substantially discounted price) and received 
next-day shipping.  
 
Where Are My Email Messages Stored?  
A number of readers have said they are confused about 

whether their saved email messages are on their own 
computer or on a remote server somewhere. Well, the 
Internet has become so ubiquitous in our lives and so 
easily available via high-speed connections that we can 
sometimes lose track of where we are.  
 
Generally speaking, all Web-based email services, such 
as Hotmail and Gmail, let users create and use folders 
at the services' locations. AOL does this, but also 
makes it easy for members to create PFCs (personal 
filing cabinets) on their own computers. Beyond this, 
however, users can create folders on their own PCs and 
copy messages into them by going to File>Save As, 
and giving the messages a name. You can also choose 
between saving messages as plain text, with a .txt ex-
tension, or as fully formatted files with an .htm (or 
.html) extension.  
 
Outlook Express Messages Saved in 2 Different 
Ways  
 
Outlook Express is an email client that expects you to 
keep saved messages on your own computer, and 
which starts you off with a few pre-established folders, 
such as Inbox and Sent Items. Once an OE message 
is downloaded, it is off the ISP's server and onto your 
PC, although you may be able to make arrangements 
with the ISP to retain copies of your messages.  
 
Outlook Express DBX Files  
 
OE messages are not only saved on your computer in 
their original format, copies of the messages are peri-
odically compressed into DBX files, which can be cop-
ied onto other media for additional security. If you are 
unfamiliar with DBX files, they are explained on my 
site on my site.  

 
Fixing Docs with Malformatted Text & those >>> 
Symbols  
 
I recently mentioned StripMail, a free program that 
fixes malformatted email with variable line lengths 
and ">" symbols. Setting aside the pointy marks for the 
moment, let's discuss why the lines of text are so un-
even.  
 
Those of us who learned to type on vintage Under-
woods and Coronas had to do a "carriage return" at the 
end of each line to move down and begin another line.  

 
 
 
 

Gerry—from page 4 

PC Don—The Senior Tutor 
Don Edrington 

www.pcdon.com 
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Computers, however, let us type continuously with 
automatic "word-wrapping" taking us from one line to 
the next. Pressing Enter is the equivalent of a CR 
(carriage return) and only needs to be done when end-
ing one paragraph and beginning another.  
 
However, it's not uncommon for PC-neophyte seniors 
to put a CR (by pressing Enter) at the end of each line, 
just as they did on their trusty typewriters. Later, if 
the message is copied to another PC which uses a dif-
ferent document width, all those CRs will cause the 
text to break in odd places. Without such arbitrary 
CRs, however, text will word-wrap to fit smoothly into 
documents of any width.  
 
Another way CRs can get planted is with a few email 
systems that force all text to conform to a now-
antiquated "pre-determined number of characters to a 
line" format. These systems also insert arbitrary CRs, 
along with placing a ">" at the beginning of each forced 
line break. StripMail can correct all this.  
 
Using Your Spell-Checker & Thesaurus  
 
Another advantage of writing with a PC is that most 
programs come with Spell-Checkers, although the tools 
appear to go largely unused. MSWord, by default, has 
Check Spelling As You Type and Check Grammar 
As You Type turned on, which causes a red squiggly 
to appear under suspected misspellings and a green 
squiggly under suspected grammatical errors.  
 
I like the spell-checking, but turn off the Grammar-
Checker by deselecting it under 
Tools>Options>Spelling & Grammar. You can also 
defeat "As You Type" spell-checking and proof the 
document at any time by pressing the ABC icon in the 
toolbar, or by pressing F7. To proof a particular word 
or phrase, mouse-select it do ABC or F7.  
 
Right-clicking a flagged word will bring up some sug-
gested corrections, or you can click ADD to add a word 
to the dictionary. Do this with names of people, places 
or technical terms not included in the default diction-
ary.  
 
A number of commonly misspelled words, such as 
"don't" will be changed to "don't" automatically. These 
words can be found under Tools>AutoCorrect, where 
you can add or delete problematical words to suit your-
self.  
 
Outlook Express, oddly, has no spell-checker of its 
own, but uses the one that comes with MSWord or 
MSOffice. When OE uses these Spell-Checkers, it will 
not correct as you type, but has other choices available 

under Tools>Options>Spelling. Google's Gmail and 
AOL email have built-in Spell-Checkers.  
 
Highlighting a word and pressing Shift+F7 in 
MSWord brings up a Thesaurus, which is pretty com-
prehensive.  
 
 

 

Preparation requires replacing the common mindset of 
independence with one of readiness and collaboration. 
An estate attorney can be a valuable resource, provid-
ing legal documents,objective advice, and what-if sce-
narios. 

Commercial services are arising to help. Denver-based 
Family Matters USA [www.familymatters.com] claims 
to have "identified, researched and solved over 120 
tasks that an estate executor or family could perform". 
They believe that while privacy issues affect all sorts of 
accounts, proper legal forms, a legitimate need, and 
perseverance (sometimes escalating to a supervisor) 
will yield the desired information. 

While organizations typically handle employees' work 
information during emergency situations, supervisors 
and individuals should inventory what they use on the 
job and how others might need to access it.  

At home or at work, the largest obstacle to emergency 
preparation is the wealth of information we use from 
memory. You can start an inventory by noting details 
of online accounts, Web site bookmarks saved, and 
passwords stored. Then make a list to share with 
someone who may need to follow in your electronic 
footsteps. Remember to safeguard your list, whether 
it's on paper, a PC, or a USB drive 
[www.aarp.org/learntech/computers/hardware/secure_
usb_drives.html]. But don't hide the list itself behind a 
secret password! 

Finally, there's a very tangible step to take. Emer-
gency responders encourage using a high-tech replace-
ment for traditional wallet contact-list cards 
[www.macmillandictionary.com/New-Words/050808-
ICE-number.htm]. They commonly check victims' cell 
phones or PDA directories for entries filed under "ICE" 
("in case of emergency") to determine whom to call. 
 

This article originated on AARP's Computers and Technology Web site, 
www.aarp.org/computers, and is copyrighted by AARP. All rights are reserved; it 
may be reproduced, downloaded, disseminated, or transferred, for single use, or 
by nonprofit organizations for educational purposes, with attribution to AARP. The 
Editorial Committee of the Association of Personal Computer User Groups 
(APCUG), an international organization of which this group is a member, brings 
this article to you. 

Accessing—from page 5 
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Puppy Linux is one of 
literally thousands of 
Linux distributions avail-
able.  Each Linux distri-
bution (a distribution is a 
flavor or version of 
Linux) contains the 
Linux kernel.  Some dis-
tributions are designed to 
be stable, some with the 
latest and greatest soft-
ware, and some are tar-

geted to a specific user group such as people that play 
games.  Puppy Linux has been designed to be simple and 
fast. 

It does this by loading the entire operating system (os) 
from a cd into ram.  There are dozens of bootable Linux 
cd's, but with all of them the cd must be left in the com-
puter's cd drive because the os must access programs 
from the cd.  With Puppy Linux once the cd is loaded it 
can be removed freeing the cd drive for other things such 
as playing music or burning new cd's.  Loading the en-
tire os into ram gives Puppy Linux its incredible speed.  
Puppy can be run on older computers and often match 
the speed and performance of the newest computers on 
the market today. 

Even though it boots from a cd, Puppy Linux can store 
persistent information to any Windows 95, Windows 98, 
or flash drive.  This means personal data such as book-
marks can be saved and available to the user even after 
the computer is shut down.  Puppy does this without 
needing a Linux partition on the computer, which elimi-
nates the need to risk creating a new hard drive parti-
tion even if you want to use Puppy on a regular basis.  
Of course if you have a Linux partition Puppy will gladly 
use it.  You can continue booting your Windows system 
like always or if you want to boot Puppy just load the cd 
and boot from the cd drive.   

Windows XP uses an NTFS partition which Puppy can 
read from, but it cannot write to.  Future versions will 
allow Puppy to work with Windows XP computers the 
same as Windows 98 (or any VFAT partition), but for 
now if Puppy is booted from a Windows XP machine the 
persistent data must be stored on a flash drive or mem-
ory card.  Puppy is so small that the entire os can be 
loaded to a flash drive, and if your computer can boot 
from a flash drive (usb drive) you would not even need to 
have a hard drive on the computer. 

I have been using Puppy since May of 2004 and love it!  
It meets my computer needs and I cannot see any reason 
for using anything else.  Bear in mind that I use my 
computer as a tool to meet only MY needs.  I want it to 
do the things I want to do, not the things everyone else 
wants it to do. 

I use Puppy to connect to the internet (with a Firefox 
web browser), read and write Word and Excel files, view 
and edit photos, read pdf files (with the Open Office ver-
sion I can create pdf files from Word or Excel files), lis-
ten to music cd's and rip songs from a music cd and con-
vert them to small mp3 files, burn data or music cd's, 
play some games, and watch dvd movies.   

Out of the box (from the bootable cd) with little or no 
additional work you can boot with Puppy Linux and do 
all of the above.  Connecting to the internet is the only 
thing that may require running a wizard.  If you are con-
necting via a network connection (like DSL or cable mo-
dem), the network connection is usually automatically 
detected, but with a modem the modem wizard will have 
to be run to properly set up the modem, the number to 
dial, and the user account.  With a little extra work 
Puppy can be configured to use a printer and a scanner. 

There are several versions of Puppy Linux.  The stan-
dard Puppy Linux distribution can be downloaded at: 
http://www.puppyos.com/download/downpage.htm and 
less than 70 M (which is VERY small compared to most 
Linux distributions that are usually 700 M or greater).  
To see screen shots go to: http://www.puppylinux.org   
There is a Puppy Linux that includes Open Office, a 
Barebones Puppy Linux that is even smaller, one built 
for gamers, and one that can be run on top of windows as 
a virtual machine.  Puppy has programs that allow you 
to "remaster" or customize the Puppy cd to only include 
the programs you want. 

Puppy Linux has steadily improved since I first began 
using it.  I use it at home on an older PC with 128 M of 
ram running on a 500 Mhz processor.  I store all of my 
data files on an sd card which allows me to carry all of 
my files with me at all times giving me access to them 
even when I am at work and have to use Windows XP.  
The desktop has the look and feel of Windows 95 and is 
simple to use.   

It does everything I want it to do and I see no reason to 
switch just to have the latest and greatest software.  
While I am not able to go into a retail store and buy off 
the shelf software (requires Windows), I have found the 
programs that come with Puppy Linux meet my needs 
(did I mention all of the programs and the os are FREE).  
How does the old phrase go: if it ain't broke, don't fix it.  
:)  I am very happy using Puppy Linux and recommend 
it to anyone considering an alternative to Microsoft 
products.          See www.puppylinux.org 

Gerry—from page 4 

Puppy Linux 
      by Tommie Gipson                                                                      
 Chautauqua Cyber Club, Inc.  



PAGE  9    CHAUTAUQUA CYBER CLUB,  INC.    VOLUME  8  ISSUE 7 

GLOBAL DATA SYSTEMS 

 
 

1031 W. Hwy 90             892-6794  /  892-5809 

               www.gdsys.net 

    

 

Club Shirt 
Size, S, M, L, XL, 2X 

$15.00                                             

50% cotton 50% polyester 

Stain resistant 

Gay Russ — mgruss@defuniak.com 

 

 

 

A Career in Computing 
 

Main Campus  Chautauqua Center 
100 College Blvd  908 W. Hwy 90 

850-678-5111  850-892-8100 

Niceville, FL 32578  DeFuniak Springs, FL 32435 

I Fix Computers 

Membership Application:   Chautauqua Cyber Club, Inc. 

Name:__________________________  Spouse:____________ 

Address:__________________________________ ZIP______ 

Telephone:____________ Email:________________________ 

(Membership is based on full 12 months: Join this month and  

renewal is same month next year  

Single and Family member-
ship are the same 

$22.00 per year 

$11.00 full time OWC        
students 
Chautauqua Cyber Club, Inc.                
P. O. Box 251, DeFuniak Springs, FL 
32435 

 

749 Baldwin Ave 

DeFuniak Springs, FL 32435 

850-892-0988 

www.defuniak.com 

Internet Service, dial-
up & high speed—full 

service home and 
business solutions 

Volunteer and help your  

community 



CHAUTAUQUA CYBER CLUB,  INC.
  
P .  O.  BOX 251 
 
DEFUNIAK SPRINGS,  FL.  32435

    Next Meeting—Sept 16  2006 
10:00 AM—Room 201 

Chautauqua Center, 908 W. Hwy 90, DeFuniak Springs, 

Membership renewal: 

It’s time to renew if the date 
on your mail label is July 06 
or before 

Announcement 
In the Fall we will have 
a “Puppy Linux” SIG with   

Tommie Gipson as               
instructor. 

see page 8 for article 

 computers for each      
participant will be         

provided for installing 
“puppy linux” 

Registration will be         
required 


